
Jovis® Network Server

Introduction

Jovis Server is a server application for relational and architectural Jovis database files.  It works only with

the multi-user version of the Jovis software.  With Jovis Server on a Macintosh network, you can access

any Jovis database file from your HyperCard, SuperCard, Oracle, MediaObjects, or Director scripts in

true multi-user fashion.

Jovis Server requires an AppleTalk or Open Transport network and System 7.1 or greater.  Jovis Server

reaches across zones on your network to allow access to Jovis databases from anywhere on your net-

work.  You don’t need any other file servers or network software

If your database usage will not be heavy and you don’t want to dedicate a Mac to the server, you can run

Jovis Server in the background, and use the same Mac for other tasks as well.

Getting Started

Installing the Server

Jovis Server doesn’t require any special installation procedure.  Just copy it onto the disk from which

you want it to run.

You want the Server to have access to all the volumes on which your database files reside.  That is, all the

volumes must be mounted on the Mac which is running the Server.

The basic SDK version of Jovis Server is configured for three clients.  Authorization for additional

clients may be purchased from DAS Works.  Your registration number and the number of authorized

clients is displayed in the "About Jovis Server"  item under the Apple menu.
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If you need to run multiple copies of Jovis Server on your network, you must purchase multiple copies.

The Server permits only one copy of each registration number to run on the network. 

Memory allocation for Jovis Server

There is nosingle  answer for how much memory to allocate to Jovis Server, but these guidelines should

help you calculate a good number for starting out.

Start with 4MB of memory.  For each increment of five clients simultaneously accessing the Server, add

another 1MB.  If the files use many large indexes, increase memory to accomodate that also.

Jovis Server does not unexpectedly quit in low memory conditions.  If there is not enough memory for it

to continue, a dialog box appears with the following warning:

You are almost out of memory.  It is recommended that you 

finish the current operation and then “Quit” Jovis Server.

This is only likely to happen when a client is trying to read or write an extremely large record, especially

sounds or pictures.

Jovis Server Preferences File

Jovis Server keeps its Server name, its Error Log, and its list of Auto Open files in a separate file, called

Jovis Server Preferences., which will be placed in the Preferences Folder inside the System Folder.

When Jovis Server is first started (and at any other time that the preferences file cannot be found or does

not exist), Jovis Server prompts the user to enter the Server name.

Naming the Server

When you run the Server for the first time, you are required to give the Server a name.  The following

dialog box is displayed when the Server is first started:

The name can be up to 31 characters long and can contain any characters except the “at” sign (@) and

colon (:).

The name must be unique among Jovis Servers within a zone.  You are allowed to have more than one

Server with the same name in different zones, but this is not recommended because it might confuse

end-users.
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Once the Server has been named, it is automatically locked.  This acts as protection against inadvertently

performing an action that could cause confusion on the network.

When the Server is locked, you are unable to access the following menu items:  New, Open, Change

Server Name, and Change Password.  If clients are logged on, the menu item Quit is also inaccessible.

Unlocking the Server

A default password has been assigned to the Server .  To unlock it, select Unlock from the Maintenance

menu [1L], and enter the default password, which is "password".  This is case sensitive, so be sure to

enter it in all lowercase.  (For further information about using passowrds, see Password Protection, fur-

ther below.)

Changing the Server Name

You may change the Server name at any time.  Just select Change Server Name under the Maintenance

menu.  For the new name to take effect, you must quit and restart the Server.

If a Server name conflict occurs because the name you previously assigned is now being used by another

Server in the same zone,  you are required to enter a new name.  In this case, the following dialog box

appears.  Enter a new name.  The Server logs you onto the network with the new name.  It is not neces-

sary to restart the Server in this situation.

Dialog box for changing the Server name.

Opening Database Files

Opening an existing file makes it available to any Jovis client on the network.  The file must be opened

first at the Server.  Use the Open command under the File menu.  If the Server is locked, the Open com-

mand is not available.  First unlock the Server using the steps described above.
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Dialog box that appears for the Open command at the Server.

Any Jovis database file may be opened from this window, provided the file is on a volume mounted on

the Mac which is running the Server.  If you want the file to be available to the entire network as read-

only, then check the box "Open read only" box below the file names.

Client Dialog Box for Opening Files

Once a file has been opened, clients on the network may open it at their stacks with the command

'OpenCollection' (for relational files) or 'DBOpen' (for architectural files).

As with the single-user version, you may specify the whole file pathname as a parameter when opening a

file from the client.  If the script does not give the file name, the following dialog box appears at the

client location:

Client dialog box for OpenCollection or DBOpen.

Notice that there are three scroll boxes containing information:  Zones, Jovis Servers, and Relational (or

Architectural) files.  The prompt will tell you what to select next.  

1)  First select a zone on your network.  (If your network does not have multiple zones, the zone

box will remain empty.  Go to step 2.)

2)  After you select a zone, all the Jovis Servers operating in that zone are displayed.  Select a Server.

If you do not immediately select a Server, the command will check the network every 6 seconds,

to refresh the list of available Jovis Servers.

3)  The third scroll box displays all the files open at the Server you selected.  Select a file name.  You

may use the Open button or double-click on the file name to open the file.  If password protec-
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tion is assigned to the file, you must enter the correct password in the dialog box or in the para-

meters when you open the file.

The Server you selected remains highlighted while it displays the available files.

Open Read-Only

If you want to open the file read-only, click in that check box.   If the file has been opened read-only at

the Server, you do not need to check here.

Open Exclusive

If you want to have exclusive use of a file, click in the "Exclusive" check box.  This means that no other

client may open that file while you are working with it.  If other clients already have the file open, you

will get an error message when you try to open the file exclusively.

You must open relational files with “Exclusive” checked when you want to make structural changes.

These include creating a relation or field, creating an index, deleting a relation or field, and deleting  an

index.

It is highly recommended, though not required, that you open architectural files with “Exclusive”

checked when you are going to make structural changes, including defining and deleting keysets.

Closing Database Files

To close a database file at the Server, select the file name in the List of Open Files window, and click on

the Close File button.This button is inactive if the Server is locked.

If any clients are logged on to the file, a dialog box warns you of that fact.  You may choose to override,

and forcibly log off the clients, but do this only when absolutely necessary.  (Refer to the List of Clients,

and Close Channel button, for further details.)

List of Open Files window, with a database file selected.

The Close File button is on the left.
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Auto-Open Files feature

When the Server starts up, it opens any files that you have designated as auto open files.If an auto open

file resides on a volume that is not online, a warning message is displayed.

If the volume is online but the file cannot be found, you are asked to find the file.  If you select a file, it

is then opened and the new location is stored.  If you select "cancel", the Auto-Open information

remains the same and no file is opened at that time.

You should know that the Server also receives instructions from database clients and keeps busy finding,

reading, and updating records and keys.  It also creates and transmits selections requested by clients.  To

avoid network bottlenecks, the Server checks for other requests while it is making or sending a selection.

This is called multi-threading.

Quitting the Server

To close the Server, select the Quit menu item under the File menu.  You may quit without closing data-

base files that are open.  The Server itself closes any open files.  Quit is inactive when the Server is

locked and any client has a database open.

To override this protection and log off the clients, unlock the Server by selecting Unlock under the

Maintenance menu.  Do not quit with clients still logged on, unless they are unable to log off.  This may

happen if the client machine crashes or the network crashes while clients are logged on.

If you do quit while clients are logged on, the following  dialog box appears, to warn you that 

clients are logged on.

If you click on the Quit button, the Server will close the channels the clients are using.  However, a

prime concern is to protect the integrity of the database files involved., so first the Server finishes any

updating which is in progress.  If any clients were making changes but had not yet executed

'CommitTransaction', the Server disregards those changes.

While the Server is taking these actions, it displays this message:
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If two minutes pass and the Server has not been able to cleanly log off all the users, a button appears in

the dialog box:

At this point, you must decide whether or not to force the Server to quit.  If you can tell by the hard
drive’s activity that the Server is still processing records (which might be the case if a large number of
records are being written to the databases), then you should wait.  If the hard drive seems to be inactive,
however, you probably need to force the Server to quit.forcing the Server to quit

Creating Database Files

Database files may be created either by an operator at the Server, or by a client using the
'CreateCollection' or 'DBInit' command.  Database files are created manually at the Server asfollows: 
Select New under the File menu.  The following dialog box is displayed:

The New File Dialog, in the process of creating a relational file 

named Second DASCPO Database File in the folder Jovis Demo.

Choose the file type (architectural or relational) and name the new file.  If you are creating a relational

file, the collection is now created and you are finished.  If you are creating an architectural file, you need

to define a keyset.  The following dialog box is displayed:

Define Keyset Dialog.
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Refer to the architectural command 'DefineKeyset'  in the syntax section for  complete instructions.

The file, once created, can be viewed in the List of Open Files.  It is already open at this point.

To place the file on the Auto-Open list, access the List of Open Files under the Maintenance menu.

Select the new file from the list, and use the Info button to bring up the File Info Dialog box, as shown

below:

File Info Dialog box for the file "Test sales db".

Check the "Auto-Open" box and click Save.  [For information on setting passwords, see the "Password

Protection" section below.]

Database files may also be created by a client , by using the command 'DBInit' to create an architectural

file, or 'CreateCollection' to create a relational file.  With the appropriate parameters, the client can name

the file, give it a custom creator type, and set the read-only and read-write passwords.  When a file is cre-

ated by a client, it is placed in the same folder as the Jovis Server application.  From the time the file is

created until that client logs off, the file is open with exclusive privileges to the client who created it.

This gives the client the opportunity to define the database structure.

When the database is closed by this client, then it becomes available to be opened by other clients.  No

further work is required at the Server.  The newly-created file is automatically added to the List of Open

Files.

Getting Information about Files:

The List of Open Files

When a file is open at the Server, its name appears on the List of Open Files.  Open this window by

selecting List of Open Files [1F] under the Maintenance menu.

If the Server is locked, List of Open Files is available, but the Close File button in the window is inac-
tive.  This window contains a list of all open files, sorted in alphabetical order. Typing a key selects the
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first file that starts with that letter.  You can also single click on a name to select that file. 

List of  Open Files window, with a database file selected.

Once you have selected a name, click on the Info button, or press the return or enter key, to bring up
the File Info Dialog for the selected file.  Double clicking on a name also brings up the File Info Dialog
for that file.

File Info Dialog for the file Test sales db

The File Info Dialog shows the volume name, file name and file type for the file.  It also shows a count
and a list of all the clients who are logged on to the file.  If the file was designated as read-only when it
was opened at the Server, that check box is checked.  There is also the check box to set Auto-Open.

There are also buttons to allow you to set the read-only password  the read/write password.  See the
"Password Protection" section for complete instructions.
Any changes you make (including passwords) are not saved unless you click on the Save button.

Getting Information about Clients:

The List of Clients

When a file has been opened by a client, the client’s name appears on the List of Clients.  The client

name is the name that appears in the Sharing Setup Control Panel on the client's Mac.  If the client Mac

Jovis® Server

Page 5-9Jovis® Copyright © 1997



has no personalized name, the name shown in the client list is the zone and node number of the client's

Mac on the network.  (This entity name is usually meaningless to anyone but a network administrator; it

is much easier if every client enters a personalized name.)

Open this window by selecting List of Clients [1U]under the Maintenance menu.  If the Server is

locked, the List of Clients is available, but the Log Off button in the window is inactive.

This window contains a list of all clients, sorted in alphabetical order.  Typing a key selects the first client

that starts with that letter.  You can also single click on a name to select that client.  Clients logged into

more than one database at a time only appear once in the Client List window.

List of Clients window, with a client name selected.

Once you have selected a name, clicking on the Info button or pressing the return or enter key brings up

the Client Info Dialog for the selected client.  Double clicking on a name also brings up the Client Info

Dialog for that client.

Client Info Dialog box for the client named Information Systems.

The Client Info Dialog shows the client name, the number of channels open , and a list of the open files.

If the client has opened the same database more than once, the file list shows a separate line for each

channel to that database file.  Each channel also shows the date and time that the channel was opened.
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Client Info Dialog box for the client named Information Systems.

The open file called Test sales db is selected.

The button on the left closes the dialog box and returns to the List of Clients window.

By selecting a file in the list and clicking the Close Channel button, it is possible to force a client out of

an opened database .  This becomes necessary when a client neglects to close the channel, or if the client

loses contact with the Server because the client machine crashes or the network crashes.  The time and

date stamp are provided to help you identify an inactive channel.

Close Channel is provided for use in extreme cases.  Do not use Close Channel unless you must.

Opening Files Automatically

The List of Auto Open Files

Auto Open Files are files that are opened automatically when you start up the Server.  You put a file on

the Auto Open list by checking the Auto Open check box in the File Info Dialog.  (Access the File Info

Dialog from the List of Open Files.)

File Info Dialog for the file Test sales db.

The Auto Open box is checked.
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Click on the Save button to make the change effective.  The next time the Server is started, the database

file will be opened automatically.

If a file has been designated Auto Open, its name appears on the List of Auto Open files.  Open this

window by selecting List of Auto Open [1A]under the Maintenance menu.

Window for the List of Auto Open files.

This window allows you to see the information about the file or to remove a file from the Auto Open

list without actually opening the file.  If the Server is locked, List of Auto Open is available, but the

Remove button in the window is inactive.

This window contains a list of all Auto-Open files, sorted in alphabetical order. Typing a key selects the

first file that starts with that letter.  You can also single click on a name to select that file.  Once you have

selected a name, clicking on the Info button or pressing the return or enter key brings up the File Info

Dialog for the selected file.  Double clicking on a name also brings up the File Info Dialog for that file.

Clicking on the Remove button removes the selected file from the Auto Open list.  The Remove button

becomes inactive when the Server is locked.

Auto Open Info Dialog for the collection EMail File.

The Auto-Open Info Dialog shows the volume name, file name, and file type for the file.  It has a check

box that shows whether the file is currently open.  It also shows a count of all the clients logged on to

the file.  If the file was designated as read-only when it was opened at the Server, that box is checked.

No changes are made at this dialog box.  It is for information purposes only.  Click on the Done button

to close the dialog box.
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Password Protection

Password Protection for the Server

The Server can be locked and protected from unauthorized actions by assigning it a password.

At the time the Server is installed, it is locked and the default password assigned to it is "password".  This

is case sensitive.

When the Server is locked, you cannot open a file, create a file, change any file information, close a client

channel, or quit the Server if there are any clients logged on.  The Server is locked or unlocked by select-

ing the first item under the Maintenance menu.  If a password has been assigned to the Server, it cannot

be unlocked without the password.

To assign a password to the Server, select "Change Server Password", under the Maintenance menu.  The

following dialog box appears:

Dialog box for assigning a password for the Server.

The password may be anything up to 31 characters in length.  It is case sensitive.  As you type in the

password, the dialog box displays the bullet (•) character.  You are required to enter the password twice.

If the password is not exactly the same both times, it will not be changed.

If you set the password to an empty string, that is the same as turning password protection off.

Each time the Server is started, it is in the same condition as when it was closed.  That is, if it was locked,

it is still locked.  If it was unlocked, then it is still unlocked when it is started again.

This allows you to keep the Server in a locked condition, if you like.  If you set your regularly needed

files to Auto Open, you can have anyone, even someone who does not know the password, start up the

Server and shut it down  again, provided no clients are logged on at that time.

Password Protection for the Database Files

You can also protect the database files with individual file passwords.  There are two levels of file pass-

words: read only and read/write.  Either or both can be set for each file.  All Jovis  files created at the

Server have these passwords set to an empty string, until passwords are assigned.  This allows everyone
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read/write access to the files.

A file created by a client will have passwords set if that client set them in the parameters passed to the

command 'CreateCollection' or 'DBInit'.

To assign passwords to a database file, first open either the List of Open Files or the List of Auto Open

from under the Maintenance menu.  Select the file you want, and click on the Info button.  This opens

the File Info Dialog for that file.  Double clicking on a name also brings up the File Info Dialog for that

file.

File Info Dialog for the file  Test sales  db

To assign a read only password, click on the button "Set Read Only Password".  To assign a read/write

password, click on the button "Set Read/Write Password".  When you click on a Set Password  button,

the dialog box for assigning a file password is displayed in front of the File Info Dialog.

File Info Dialog for the file Test sales db.

The dialog box for assigning a password

is displayed here across the File Inzfo Dialog.

The password may be anything up to 31 characters in length.  It is case sensitive.  As you type in the

password, the dialog box displays the bullet (•) character.  You are required to enter the password twice.

If the password is not exactly the same both times, it will not be changed.
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If you set the password to an empty string, that is the same as turning password protection off.

The algorithm for determining client access to a file based on the the password is as follows: 

1. If the client requests read only access, then

a. If the read only password is empty, then log on as read only.

b. If the client password is the same as the read only password, then log on as read only.

c. If the client password in incorrect,  then don’t log the client on, and return an error.

2. If the client requests read/write access, then

a. If the read/write password is empty, then log on as read/write.

b. If the client password is the same as the read/write password, then log on as read/write.

c. If the client password is not the same as the read/write password:

i. If the read only password is empty, then log on as read only.

ii. If the client password is the same as the read only password, then log on as read only.

iii. If the client password is neither the read/write nor the read only password, then don’t log

the client on, and return an error.

Error Log Window

Errors, such as communication errors reported to the Server, are logged in an Error Log window.  This

window can be opened from the Maintenance menu.  The error messages will identify the time and date

of the error, the client involved, and the nature of the error.

When the contents of the window approaches 32k, the Server writes a message into the window that

soon it will begin removing its oldest messages to make room for incoming messages.  The window con-

tains a button that allows you to dump the contents to a text file.

List of Menu Items

The File Menu:

New 1 N
Creates new database files which will be available on the network.  Opens a dialog box in which you

give the name of the new file and specify whether it is an architectural or relational file.
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If you are creating an architectural file, you are required to enter the information necessary to define

a keyset.  Then the file is shown in the List of Open Files window.

Open 1 O
Opens a Jovis file and makes it accessible to the network clients.

When opening the file, you can designate it as read only.  This restricts clients to read only access,

even if they know the read/write password for the file.

Close Window 1 W

Closes the active window.

Quit 1 Q
Closes the Server and all the open database files.  You are warned about any databases still open by

clients.  You cannot quit if the Server is locked and clients are logged on.

The Edit menu is the standard menu with the usual items, but it is not active unless you open a desk

accessory.  None of its features are used by Jovis Server.

The Maintenance Menu:

Lock/Unlock  - 1 L

Changes the status of the Server. Lock restricts the actions that can be performed.  It can be activat-

ed from the menu; when the Server is locked, the menu item then becomes Unlock.

When Unlock is selected, it prompts for the appropriate password (if a password has been set for the

Server).   Until the Server is unlocked, you are unable to access these menu items:  New, Open,

Change Server Name, Change Password, and Quit (if clients are logged on).

Change Server Name...

Allows you to change the name of the Server as it appears to other entities on the network.  The new

name is not recognizable to others until you quit and restart the Server.
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Change Password …

Allows you to change the password protecting the Server.  The password can be anything up to 31

characters in length, and is case sensitive.  As you type in the password, the dialog box displays the

bullet (•) character.  You are required to enter the password twice.  If the password is not exactly the

same both times, it is not changed.  If you set the password to an empty string, it is the same as turn-

ing password protection off.

List of Open Files 1 F
Opens a window that shows which database files are currently open at the Server.

List of Auto Open Files 1 A
Opens a window that shows which database files have been designated as “Auto-Open”.  This means

that every time the Server is started, these database files are opened without further action being

taken by the person working at the Server.

List of Clients 1 U
Opens a window that shows a list of all clients who currently have database files open.

Error Log 1 E
Opens a window that shows a list of all Jovis errors reported to the Server.

Set Server ShutDown

Used to schedule an automatic shutdown time to allow backup systems (such as Retrospect®) to do

their job.  This is intended to be set for a time when no one is in the office, such as 2 am, so server

maintenance does not interfere with working hours.

First select Set Server ShutDown from the Maintenance menu.  The "Server ShutDown Time" dialog

box appears:

Server ShutDown  Time dialog box

Enter the time you wish to have the server automatically begin the shut down process.  Click the

"On" radio button , and click OK.

At the designated time, the shut down process, which takes 6 minutes, begins.  During this process,

the Server closely monitors any activity on any files.  If any activity is detected, the shutdown

process is aborted.  This would include log-ons, log-offs, or any changes to any files.

If no activity is detected, all clients are logged off, and all files are saved and closed.  Finally, the
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Server shuts down.  The Server will beep every 30 seconds from the initiation of shut down until

completion of the shutsdown process.  When shut down is complete, the backup application can

safely be launched.  Be sure to allow for the required six minutes for Server shutdown when setting

the start time for the backup application.
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